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Introduction
Microsoft Excel is a spreadsheet program that provides an advanced combination of power, flexibility, and accessibility to listing and analyzing data.  

This User’s Guide covers Excel topics at the basic and intermediate level.
The Excel Main Window
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Key Definitions
	Cell Reference
	Excel uses the A1 reference style, which labels columns with letters (A through IV) and rows with numbers (1 through 65536).  To refer to a cell, enter the column letter followed by the row number.  A reference identifies a cell or a range of cells on a worksheet and tells Microsoft Excel where to look for the values or data you want to use in a formula.

	Cell/Active Cell
	A cell is the intersection of a row and a column.  The active cell is where you are entering data.

	Close Button – Excel Application
	The Excel Application Close Button, at the top right corner of the Excel Application Window, will close Excel. If there are any workbooks open, they will be closed. (If any workbooks have not yet been saved, you will be prompted to save before closing.) 

	Close Button – Workbook
	The Workbook Close Button on the menu bar will close the workbook

	Fill Handle
	The fill handle is the small black square in the lower right corner of a selection. When you aim your mouse pointer at the fill handle, the pointer changes to a black cross. You can copy contents to adjacent cells or to fill in a series such as dates by dragging the fill handle. 

	Formatting Toolbar
	The formatting toolbar has buttons and drop-down lists that allow the user to modify the appearance of selected text.

	Formula Bar
	The formula bar displays the contents of the active cell (text, numbers, or formulas).

	Formulas
	Formulas are used to perform calculations on numeric entries.  Formulas can range from a simple addition equation to a very complex equation.

	Maximize/Restore Down Button
	The Maximize/Restore Down Button allows you to enlarge the active window to full screen size, or to change the size back to a smaller size on the desktop.

	Menu Bar
	The menu bar contains the names of the command menus available in Excel.

	Minimize Button
	The Minimize Button reduces the active window.  Clicking this button does not close the program it simply stores the window at a reduced-size in the Taskbar.

	Numbers
	Data values containing digits between 0 and 9, including a decimal point, if present.  Negative numbers are preceded by a minus sign.

	Name Box
	The Name Box displays the cell address of the active cell, or the name of the active range.

	Scroll Bars
	The scroll bars allow you to move through a worksheet vertically or horizontally.

	Sheet Tabs
	In Excel, a workbook is the file where your data is stored.  Each workbook may contain many sheets.  The names of the sheets appear on the tabs at the bottom of the workbook window.

	Smart Tags
	You can save time using Smart Tags to perform actions in Microsoft Excel that you'd usually open other programs to perform. Note: Smart tags are turned off by default in Excel.

	Standard Toolbar
	The standard toolbar contains shortcut buttons for executing commonly used commands.  

	Status Bar
	The status bar displays messages, prompts, and information about the active document.

	Task Panes
	Task panes are helper windows that open automatically on the right or left side of your window when you perform certain tasks such as starting a new document, asking a Help question, inserting clip art.


	Text
	Any entry containing letters.

	Title Bar
	The Title Bar displays the name of the current application and document.  Every time you initialize an Excel session, Microsoft Excel - Book1 is shown in the title bar until the document is named and saved.

	Work Area
	The work area displays the open workbook you are working with.

	Workbook
	A workbook is a file, produced by the Excel Application. It is where your data is stored.  Each workbook can contain many worksheets. This helps you to organize various kinds of related information in a single file.

	Worksheet
	Worksheets are used to organize and separate data. You can enter and edit data on several worksheets simultaneously and perform calculations and analyses based on data from multiple worksheets. 


Shortcuts/Tips

Common Shortcut Keys 

	If you want to . . . 
	Use the following shortcut keys . . . 

	Repeat your last action
	F4 or CTRL+Y

	Find and replace
	CTRL+F

	Go to page, section, line, etc.
	CTRL+G

	Delete a word
	CTRL+BACKSPACE

	Change case
	SHIFT+F3

	Bold
	CTRL+B

	Italicize
	CTRL+I

	Go to the beginning of the document
	CTRL+HOME

	Go to the end of the document
	CTRL+END

	Select to the beginning of the document
	CTRL+SHIFT+HOME

	Select to the end of the document
	CTRL+SHIFT+END

	Open the thesaurus
	SHIFT+F7

	Insert a hyperlink
	CTRL+K

	Select all
	CTRL+A

	Copy
	CTRL+C

	Paste
	CTRL+V

	Undo
	CTRL+Z

	Save
	CTRL+S

	Print
	CTRL+P

	Open
	CTRL+O

	Insert a new worksheet
	SHIFT+F11 or ALT+SHIFT+F1

	Create a chart that uses the current range
	F11 or ALT+F1

	Display the Macro dialog box
	ALT+F8

	Display the Visual Basic Editor
	ALT+F11

	Insert a Microsoft Excel 4.0 macro sheet
	CTRL+F11

	Move to the next sheet in the workbook
	CTRL+PAGE DOWN

	Move to the previous sheet in the workbook
	CTRL+PAGE UP


Keys for Entering Data on a Worksheet

	If you want to . . .
	Press . . .

	Complete a cell entry and move down in the selection
	ENTER

	Start a new line in the same cell
	ALT+ENTER

	Fill the selected cell range with the current entry
	CTRL+ENTER

	Complete a cell entry and move up in the selection
	SHIFT+ENTER

	Complete a cell entry and move to the right in the selection
	TAB

	Complete a cell entry and move to the left in the selection
	SHIFT+TAB

	Cancel a cell entry
	ESC

	Delete the character to the left of the insertion point, or delete the selection
	BACKSPACE

	Delete the character to the right of the insertion point, or delete the selection
	DELETE

	Delete text to the end of the line
	CTRL+DELETE

	Move one character up, down, left, or right
	Arrow keys

	Move to the beginning of the line
	HOME

	Repeat the last action
	F4 or CTRL+Y

	Create and edit a cell comment
	SHIFT+F2

	Create names from row and column labels
	CTRL+SHIFT+F3

	Fill down
	CTRL+D

	Fill to the right
	CTRL+R


Using Smart Tags

A Smart Tag is a button containing a menu that appears after you perform certain actions. They help by informing you of the options available to you. For example, if you recently sent mail to "Nate Sun", and you type the name into a cell on an Excel worksheet, the name is recognized and given a smart tag with actions you can take including Send Mail, Schedule a Meeting, Open Contact, or Add to Contacts. The smart tag indicators appear in the cell on your worksheet as you type. They may also appear when you open a previously saved document.

Note:  Smart tags are turned off by default in Excel.

To use Smart Tags
When Excel recognizes types of data, the data is marked with a smart tag indicator— a purple triangle in a worksheet cell. To find out what actions you can take with a smart tag, move the insertion point over the text with a smart tag indicator until Smart Tag Actions [image: image2.png]


appears, and then click the arrow next to the button to see a menu of actions.
Other buttons you may see in your worksheet

At times other buttons may appear as you work in your workbook.

	[image: image3.png]



	AutoCorrect Options
	First appears as a small, blue box when you rest the mouse pointer near text that was automatically corrected, and changes to a button icon when you point to it.

If you find on occasion that you don't want text to be corrected, you can undo a correction or turn AutoCorrect options on or off by clicking the button and making a selection.
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	Paste Options
	Appears just below your pasted selection after you paste text or data. When you click the button, a list appears that lets you determine how the information is pasted into your worksheet.

The available options depend on the type of content you are pasting, the program you are pasting from, and the format of the text where you are pasting.

	[image: image5.png]B





	Auto Fill Options
	Appears just below your filled selection after you fill text or data in a worksheet. When you click the button, a list appears to give you options for how to fill the text or data.

The available options depend on the content you are filling, the program you are filling from, and the format of the text or data you are filling.
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	Trace Error
	Appears next to the cell in which a formula error occurs, and a green triangle appears in the upper-left of the cell. When you click the arrow next to Trace Error, a list appears to give you options for error checking.
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	Insert Options
	Appears next to your inserted cells, rows, or columns. When you click the arrow next to Insert Options, a list of formatting options appears.


Task Panes
The Task Pane opens when you start a program, usually along the right side of your window. Task Panes eliminate the need for frequent trips to the menu bar by putting commonly used functions all in one area.

With Task Panes you can easily and efficiently perform certain tasks such as starting a new document, asking a Help question or inserting clip art.
To view the Task Pane 
On the View menu, click Task Pane. It pops right up on the left or right side of your window (or top or bottom; wherever you left it last time).
To close the Task Pane 
Click the little x in the top right corner of the task pane.

To move the task pane

Drag the handle. 
To navigate forward or back through the panes you have been working with

Click the forward and back arrows. 

	To select another task pane, 

Click the arrow next to the name of the task pane you're in to open a drop down list of available Task Panes. Click the task pane you want. 
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Commonly Used Task Panes

	Getting Started
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The task pane offers three basic ways to get you up and running:

Microsoft Office Online: 

Specially chosen links to help you get started. These links may be assistance articles, templates, Marketplace listings, and whatever else is available to you on Office Online.
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Search for: 

Where you can type a question and get help. 
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Open: 

Displays a list of the files that you were working on before you closed the program. Just click the name of one to open it.
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Also has a button to create a new workbook.
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	Search Results and Help 
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The Search Results task pane and the Help task pane are closely related. You can automatically open the Help task pane by pressing F1. Type your question in  Search for: and hit enter.  
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	After the program searches for an answer, the Search Results task pane opens and you can pick from a list of answers. If you don't see a suitable answer, you can try your search again.

When you search for help from within a program, a icon appears next to your search results. The icons are:
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Help topic
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Web article
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Training course
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Office Marketplace listing
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Word template
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The Excel 2003 Main Window

« Tochange the format of the date and/or time
1. Right-click the cel, click on Format Cells
2. Onthe Number tab select Date or Time
3 Select the formatting you prefer

- To edit a cells contents
© While you are typing into a cell
- You can press Backspace to erase what you have typed
- Use Esc, Cancel or click the red X on the left end of the formatting bar to
delete the whole entry
o After you have entered data into a cell
=" Clicking in the formula bar wil give you an insertion point allowing you to edit
the contents
~ Double-clicking in the cell will give you an insertion point allowing you to edit
the contents

Moving a cell's contents to another cell
o Using Drag and Drop is a great way to move data short distances
1. Select the cel or range of cells
2. Point to and click the heavy border surrounding the cell(s) the mouse changes to
afour-headed arrow|

Tips for copying data

= To quickly fil in the active cell with the contents of the cell a
To il in with cortents of the cell to the lef, press CTRL+R.
* ITyou drag the fil handle up orto the Ieft of a selection and stop in the selected cells

w ]
BE»-L-A-=msas)

press CTRLD,

e

Paste it however, the difference is
significant when formulas are involved
When using the Drag and Drop
method, cell references are updated

1. Select the cell(s) to be moved
HINTS:
To select an indvidual cell,
click that cell
To select multiple contiguous
cells, click and drag across the
desired cells

2. Paint to and click the heavy
border surraunding the cell(s)
The mouse pointer changes to

a four-headed arrow.

Il
Il
Il
I

5,115.00

:nmy Border

3. Holding the mouse button, drag
the cell(s) to the new location
NOTE: An outline of the cell(s)
you ate moving will appear over
the new location. As you move
the cell(s), a box appears next
to the nointer indicatina the cell

sl

Sec 3 A48 Ln2l

Draw~ I | Autoshapes~ \ N\ 1O & 4
Gzt e we e om GX

| [Elowme

e

My Computer

Page 21 2124
Astart||| 1] & 2 ] ] || &escelz0.. [Eencel 20.

[EMcrosaft...| Buamsexc...| @microsaft...|

DEHL amm




 SHAPE  \* MERGEFORMAT 

[image: image16]



	The Clipboard

Collect up to 24 items and view a thumbnail of any item that can be cut or copied, such as text and graphics. When you're ready to paste, you can paste all at once, one at a time, or change your mind and delete all at the same time.
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Getting Started in Excel

By default, blank Excel workbooks contain three worksheets. You can add up to a total of 256 worksheets. Each worksheet has 256 columns and 65,536 rows. Each column is labeled with a letter and each row is labeled with a number.

The intersection of a column and a row is called a cell, and each cell has a unique name/address that comes from combining the column letter with the row number such as, C4 or A1. These addresses are also called cell references.
Examples of cell references:
	To refer to
	Use

	The cell in column A and row 10
	A10

	The range of cells in column A and rows 10 through 20
	A10:A20

	The range of cells in row 15 and columns B through E
	B15:E15

	All cells in row 5
	5:5

	All cells in rows 5 through 10
	5:10

	All cells in column H
	H:H

	All cells in columns H through J
	H:J

	The range of cells in columns A through E and rows 10 through 20
	A10:E20


Working With Workbooks
	Creating a New Workbook

To create a new document based on the regular template, click on New

Or
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	1. On the File menu, select New

2. On the Getting Started taskpane click Create New Workbook
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	3. Click on Blank workbook
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	To Save a Workbook click Save.

If this is the first time the file is being saved you will be asked to give it a name.
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Formatting Numbers
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Formatting cells for numbers can be very
helpful and time-saving. You can format
cels to display time, cunrency, nurmbers,
etc. in the desired style

Formatting Numbers:
Toolbar Opf

1. Select the cell(s) to be formatted

2. On the Formatting toolbar, click
the desired formatting option
NOTES:

Holding the pointer over a toolbar
button for a short period displays
& description of that option

Ifthe desired option s not
available on the Formatting
toolbar, refer to Formatting
Nursbers: Meny Option

Formatting Numbers:
Menu Option

1. Select the cell(s) to be formatte)

2. From the Format meny, select
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Using the Mouse

The shape of the mouse pointer changes depending on the task it is performing.

	Shape
	Implication
	Action
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	The default pointer shape.
	Selects a cell or range of cells
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	Appears when on the border of a column, row or window.
	Adjusts the column width, row height or size of the window.
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	Appears when you are editing the contents of a cell.
	Move the insertion point within the cell.
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	Appears when you have a graphic that may be moved.
	Moves the selected graphic to the new location.
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	Appears when you are pointing to the border of a cell or range of cells.
	Moves the selected cell to a new location.

	 SHAPE  \* MERGEFORMAT 



	Appears when you are at the “fill handle” of a cell or range of cells.
	Autofills other cells with similar information.


Selecting a cell and a range of cells

The selected cell or range of cells will be identified by a dark outline.

	A cell 
	Click in the cell.

	Text in a cell
	Double-click the cell to get an insertion point.

	A column 

	Click the column heading
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	A row
	Click the row label
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	Entire worksheet
	Click the Select All button
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	Non-adjacent cells, columns or rows
	Hold the control key when selecting the cells, rows or columns you want.
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	A large range of cells
	Click the first cell in the range, and then hold down SHIFT and click the last cell in the range. You can scroll to make the last cell visible.
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	Select another sheet in a workbook


	Click the Sheet Tab for the desired sheet. 

If you don't see the tab you want, click the tab scrolling buttons to display the tab, and then click the tab. 
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Working with Worksheet Data

Excel can work with three kinds of data:
Labels: Text values such as name and addresses, as well at date and time values

Numbers: Numeric values such as 34, -291, 545.67874 and 0.

Formulas: Expressions that compute numeric results. 

Entering and Editing Numbers, Text, and Date/Time

To enter numbers, text, dates or times

1. Click the cell where you want to enter data

2. Type the data

3. Press ENTER to enter the data into the cell and move the active cell one row down.

Or

4. Press TAB to enter the data into the cell and move the active cell one column to the right.

Or

5. Click the green checkmark to the left of the formula bar to enter the data but not change the location of the active cell.

Note: If the width of your data is greater than the cell’s original width, and the adjacent cell is empty, the entire contents of the entry will be displayed. However, if the adjacent cell contains data, Excel will only show as much text as fits in the cell’s width and displays the contents of the adjacent cell.

Enter the same data into several cells at once

1. While holding the Ctrl key, click the cells where you want to enter data. The cells do not have to be adjacent. 

2. Type the data and press Ctrl+Enter

Tips on entering text

· By default all text is left-aligned in a cell. 

· To display all the text on multiple lines in the cell, select the Wrap text check box on the Alignment tab on the Format dialogue box.

· To enter a "hard" carriage return in a cell, press ALT+ENTER. 

Tips on entering numbers

· A number can contain only the following characters:  0 1 2 3 4 5 6 7 8 9 + - ( ) , / $ %. 
· Excel ignores leading plus signs (+) and treats a single period as a decimal.  All other combinations of numbers and nonnumeric characters are treated as text.
· Start negative numbers with minus sign or enclose numbers in parentheses ( ).
· By default all numbers are right-aligned in a cell. 
Tips on entering dates and times

· Dates and times are considered numbers. 
· Key in the day first and then the year.
· To type a date and time in the same cell, separate the date and time with a space.
· To type a time based on the 12-hour clock, type a space followed by AM or PM (or A or P); for example, 9:00 p. otherwise, Microsoft Excel enters the time as AM. To enter the current time, press CTRL+SHIFT+: (colon).
· To enter a date, use a slash or a hyphen to separate the parts of a date; for example, type 9/5/2002 or 5-Sep-2002. To enter today's date, press CTRL+; (semicolon).
To edit a cell’s contents

	While you are typing into a cell

· You can press Backspace to erase what you have typed
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Use Esc, Cancel or click the red X on the left end of the formatting bar to delete the whole entry
After you have entered data into a cell 

· Click the cell you want to edit and click anywhere in the formula bar 
· Or
· Double-click in the cell
Either action will position an insertion point in the cell or formula bar so you can edit the cell contents.
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Copying and Moving Data

Copying works well for duplicating formulas, values and labels without reentering them.

	Copy data to an adjacent row or column

1. Select the cells that contain the data you want to copy. 
2. Using the mouse, drag the fill handle to the adjacent column or row and release the mouse.
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	Copy and Paste to copy text to a non-contiguous location
1. Select the cell(s) to be moved 
2. Right-click in the highlighted area
3. Click Cut
4. Right-click in the new location and click Paste
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	Using Drag and Drop to move data short distances

1. Select the cell or range of cells
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Point to and click the heavy border surrounding the cell(s) the mouse changes to a four-headed arrow.
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3. Holding the mouse button down, drag the cell(s) to the new location. 
4. When you reach the desired location, release the mouse button
Note:  An outline of the cell(s) you are moving will appear over the new location. As you move the cell(s), a box appears next to the pointer indicating the cell location.
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	Using Cut and Paste to move large amounts of text a greater distance
1. Select the cell(s) to be moved 
2. Right-click in the highlighted area Click Cut
3. Right-click in the new location and click Paste
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Using AutoFill

Use Fill to repeat information to contiguous cells. If Excel recognizes a pattern in the information you entered, the additional cells will contain the next item in the pattern. For example, if the first cell contains the day Sunday, Excel will fill the following cells with Monday, Tuesday, etc. The same thing happens for months of the year and for dates.
	· Fill in a series of days, dates, or months
1. Select the first cell in the range you want to fill. 
2. Enter the starting value for the series.
3. If necessary enter a value in the next cell to establish a pattern.
4. Select the cell or cells that contain the starting values.
5. Drag the fill handle over the range you want to fill.
Note: A smart appears with a choice of fill options.
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	Fill in a series of numbers

1. Select the first cell in the range you want to fill. 
2. Enter the starting value for the series.
3. If necessary enter a value in the next cell to establish a pattern.
4. Select the cell or cells that contain the starting values.
5. Hold the Ctrl key and drag the fill handle over the range you want to fill.
Note:  If you don’t hold the Ctrl key, you will just get a copy of the same number. Remember to release your mouse before letting go of the Ctrl key.
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	Create custom fill lists

Custom fills allow you to select what information you want repeated. For example, if you frequently typed in a list of names in the same order custom fills allows you to automate the process.

1. Tools menu, Options
2. Custom Lists tab
3. Select New List
4. In the List entries text box, type the information you want to be added in the custom fill.
5. Press Enter after each entry.
6. Click Add. Your new entries appear in the Custom lists scroll list.
7. Click OK
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Using Formulas and Functions
	Formulas can contain any or all of the following:

function

A prewritten formula that takes a value or values, performs an operation, and returns a value or values. For example, you can use the SUM function to add the values in a range of cells. Use functions to simplify and shorten formulas on a worksheet, especially those that perform lengthy or complex calculations.

operator

A sign or symbol that specifies the type of calculation to perform within an expression. There are mathematical, comparison, logical, and reference operators.

constant

A value that is not calculated and, therefore, does not change. For example, the number 210, and the text "Community Relations" are constants. An expression, or a value resulting from an expression, is not a constant.)

relative references

In a formula, the address of a cell based on the relative position of the cell that contains the formula and the cell referred to. If you copy the formula, the reference automatically adjusts. A relative reference takes the form A1.

name

A word or string of characters that represents a cell, range of cells, formula, or constant value. Use easy-to-understand names, such as Products, to refer to hard to understand ranges, such as Sales!C20:C30.

formula bar

A bar at the top of the Excel window that you use to enter or edit values or formulas in cells or charts. Displays the constant value or formula stored in the active cell.

argument

The values that a function uses to perform operations or calculations. The type of argument a function uses is specific to the function. Common arguments that are used within functions include numbers, text, cell references, and names.


	To create a formula:

1. Select the cell where you want the formula to appear
2. To begin a formula always type = (equal sign) To continue the formula, type the numbers, cell references and the operator
3. To accept the formula, press Enter
For example:

To add the number of Blue Pens and the number of Red Pens type: =B2+B3
To subtract the number of Blue Pens from the number of Red Pens type: =B2-B3
To multiply the # of Red Pens by the cost type: =B2*C2
To find out the per pen cost for the Blue Pens type: =D3/B3
Because you create formulas using cell references, if the cell values change, the result of the formula will still be correct.
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	AutoSum:

AutoSum quickly adds the contents of contiguous cells in either a column or row.

Click a cell below the column of numbers or to the right of the row of numbers. 

Click AutoSum [image: image40.png]


on the Standard toolbar, and then press ENTER. 




Relative and Absolute References

Most of the time, when you enter a formula you will use relative referencing. If you insert or delete rows, columns or cells, your formulas remain accurate because the cells that they reference change as your worksheet changes.

	Relative references

In a formula, the address of a cell is based on the relative position of the cell that contains the formula and the cell the reference refers to. If you copy the formula across rows or down columns, the reference automatically adjusts. By default, new formulas use relative references. 

In this example, when the formula from column A was copied to column B, the cell addresses adjusted.
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	Absolute references 

In a formula, the exact address of a cell, regardless of the position of the cell that contains the formula. If the position of the cell that contains the formula changes, the absolute reference remains the same. 

In this example, in order to calculate the percent each formula had to reference B10.

To do this a $ had to be typed before the B and before the 10. 
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Using Functions

A function is a prewritten formula that takes a value or values, performs an operation, and returns a value or values. Use functions to simplify and shorten formulas on a worksheet, especially those that perform lengthy or complex calculations.
Insert Function Dialog Box

The Insert Function dialog box will display a listing of all functions or categories of functions available with Excel. As you select a function, a sample of the function appears at the bottom of the dialog box.

	To write a function using the Insert Function dialog box:

1. Click the cell in which you want to enter the formula.
2. Click Insert Function [image: image43.png]


 on the formula bar. The Insert Function dialog box will appear.
3. In the Select a category scroll list select the desired function. A description of the selected function appears beneath the Select a function scroll list.
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	4. Click OK and the Function Arguments dialog box appears. 
The Functions Arguments dialog box helps you to enter worksheet functions. As you enter the function the dialog box displays the name of the function, the function arguments, a description of the function, a description of the arguments and the result of the function.

5. Enter the arguments. To enter cell references as an argument, click Collapse Dialog [image: image45.png]


 to temporarily hide the dialog box. Select the cells on the worksheet, then press Expand Dialog[image: image46.png]



6. When you complete the formula, press OK. 
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Formatting the Worksheet

AutoFormat
To make formatting a little easier, Excel has several “preset” formats available. Once you apply formatting with AutoFormat you can still make adjustments to the cells.

1. Select the cell(s) to be formatted
2. Format menu, AutoFormat
3. Select the desired AutoFormatting option
4. When finished, click OK

[image: image48]
Working with Rows and Columns
	To insert a column

1. Click the heading of the column to the right of where you want the new column
2. Right-click in the highlighted area
3. Click on Insert
Note: To insert multiple columns select an equal number of columns. Ex: To insert 3 new columns, select 3 columns and then right-click.

To delete a column:

1. Click the heading of the column to be deleted
2. Right-click in the highlighted area
3. Click on Delete

	 SHAPE  \* MERGEFORMAT 




	To insert a row

1. Click the heading of the row below where you want the new column
2. Right-click in the highlighted area
3. Click on Insert
Note: To insert multiple rows select an equal number of rows. Ex: To insert 3 new rows, select 3 rows and then right-click.

To delete a row:

1. Click the heading of the row to be deleted.
2. Right-click in the highlighted area
3. Click on Delete
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	To adjust the row height and column width

1. Point the mouse at the boundary to the right of the column or at the bottom of the row you want to adjust.  The mouse will turn into a 2 headed arrow 

to adjust the row       SHAPE  \* MERGEFORMAT 


 

or to adjust the column SHAPE  \* MERGEFORMAT 


.
2. Drag the arrow down to increase row height or drag the arrow right to increase the column.

Or

1. Right-click the column or row heading, select Column width or Row height

2. Type in a number.

To auto-fit the column or row to the contents of widest cell or tallest row

Point the mouse at the boundary and double-click the arrow 
To change the column width for multiple columns:  
Select the columns you want to change and use one of the methods described above.
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	Cell Alignment

Be default text is always aligned left in a cell and numbers are always aligned right. To change this, use the cell alignment buttons on the formatting toolbar.  SHAPE  \* MERGEFORMAT 





	To change horizontal and vertical alignment and text orientation:

1. Right-click the cell(s) you want to format.
2. Select Format Cells
3. Click Alignment Tab
4. Make selections 
	 SHAPE  \* MERGEFORMAT 




	Borders and Shading



	Using predefined border styles

On a worksheet, select the cell or range of cells to which you want to add a border, change the border style, or remove a border. 

Click the arrow next to Borders on the Formatting toolbar, and then choose a border style from the palette. 


	
[image: image56]

	To apply a custom border style or a diagonal border 

1. On a worksheet, select the cell or range of cells to which you want to add a custom border.
2. Right-click the cell or range of cells you want to format.
3. Select Format Cells
4. Click on the Border tab
5. Select the Style, Color and location you prefer
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	Add shading to a cell or range of cells

1. Select the cell or range of cells that you want to apply shading to or remove shading from. 
2. To fill cells with a solid color, click the arrow next to Fill Color [image: image58.png]


on the Formatting toolbar and then click the color that you want on the palette. 
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	To apply a custom border style or a diagonal border 

1. On a worksheet, select the cell or range of cells to which you want to add a custom border.
2. Right-click the cell or range of cells you want to format.
3. Click on Format cells
4. Select the Patterns tab
5. On the Patterns tab, under Cell shading, click the background color that you want to use for the pattern. 
6. Then click the arrow next to the Pattern box, and click the pattern style and pattern color. 
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	Merging Cells and Wrapping Text

If you have several cells that you would like to combine so they become a single cell



	Merge Cells

1. Select the cells you want to merge
2. Right-click in the highlighted area
3. Select Format Cells
4. Click on the Alignment Tab
5. Under Text control click in the Merge cells box
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	Merging and Centering Text

Merging and centering text can add a professional appearance to your worksheets. It is useful for title and headings so they are not broken up into different cells or displayed with inappropriate alignment.

1. Type the desired text in the first cell of the group to be merged.
2. Select the text and a cell from each column you want merged.

3. On the Formatting toolbar click Merge and Center  SHAPE  \* MERGEFORMAT 



Or

1. Select the cells you want merged

2. On the Formatting toolbar click Merge and Center   SHAPE  \* MERGEFORMAT 



3. Type the desired text and hit enter.

	To unmerge the cells

1. Right-click in the merged cell
2. Click on Format Cells
3. Select the Alignment tab
4. Under Text control remove the check-mark from Merged cells
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	Wrapping Text

If you have text that appears in a single cell and you want to increase the height of that cell to accommodate all of the words, use the Wrap text option.



	To wrap text:

1. Select the cells to which Wrap text will be applied
2. Right-click in the highlighted area
3. Click Format cells
4. Select the Alignment tab
5. Under Text control select Wrap text
To unwrap the text 
Follow the above steps and remove the check mark
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	Copying Cell Formatting

Copy and paste will copy text and all associated formatting. If you want to copy only the formatting, use the Format Painter.

	To use the Format Painter

1. Highlight the cell containing the desired formatting.
2. On the Standard toolbar click Format Painter  SHAPE  \* MERGEFORMAT 



3. Click the cell you want to format.
Note:  Clicking the Format Painter once, allows you to use it once. If you want to use the Format Painter several times, click it twice. When you are finished be sure to click on the button again to turn the feature off.



	To clear cell formatting

1. Select the cell(s) containing the formatting to be cleared
2. Edit menu, Clear, Formats


	Formatting Numbers:

Numbers can be quickly formatted by using the buttons on the Formatting toolbar SHAPE  \* MERGEFORMAT 


.


	More number formats

1. Right-click the cell(s) you want to format
2. Click on Format Cells
3. Select the Number tab
4. Choose the appropriate format.
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Setting Up and Printing a Worksheet

The Page Setup dialog window
The Page Setup provides many options for customizing your print settings. Changes are made for each sheet individually. 
To open the Page Setup dialog box; Open the File menu, select Page Setup
There are four tabs in the Page Setup dialog box. Each will be reviewed separately.
	The Page Tab

Option

Description

Orientation

Selects the width of the printed page. Most documents are portrait; however, many worksheets may be easier to read in the landscape mode.

Scaling

Adjusts the percentage of the printed copy’s actual size. Options are available for fitting all columns or rows to a certain number of pages. The default size of the printed copy is 100%.

Paper size

Selects the paper size to match the stock currently loaded in the printer.
Print Quality

Adjusts the resolution of your printer.
First page number

Sets the page number that will print on the first page. If you want the first page number to be number one (1), leave the selection on Auto.

[image: image68]



	Notes: 
· Microsoft Excel ignores manual page breaks when you use the Fit to option. 
· When you change the values for Fit to, Excel shrinks the printed image or expands it up to 100 percent, as necessary. To see the how much the image will be adjusted for your new values, click OK, and then click Page Setup on the File menu. The Adjust to box on the Page tab shows the percentage that the printed size will be adjusted.
· Printed data does not exceed the specified number of pages. Excel does not enlarge the data to fill the pages. 

	The Margins Tab

Provides options enabling you to set all your margins and center your sheet both vertically and horizontally. 
Option

Description

Top, Bottom

Adjusts the top and bottom margins.

Left, Right

Adjusts the left and right margins.

Header, Footer

Adjusts the location of the header and footer.

Center on page

Centers the worksheet on a printout horizontally, vertically or both. 
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	The Header Footer Tab

Allows you to access options to adjust the information at the top and/or bottom of each page. They may contain the date, page number, filename, text or the contents of a cell.
Excel has two types of headers and footers available. The first, preset, is make up of samples and headers or footers you have used in the past. The second type, custom, is created by you.

Option

Description

Header

Offers a choice from a list of preset headers. Previously used headers will appear in this list.

Custom Header

Allows you to create your own header. Options include adding time, data, page numbers and text. In addition, you can change the font associated with all of these options.

Custom Footer

Allows you to create your own footer. Options include adding time, data, page numbers and text. In addition, you can change the font associated with all of these options.

Footer

Offers a choice from a list of preset footers. Previously used footers will appear in this list.
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Instructions for Headers and Footers 

	The Sheet Tab

Provides you with several options for selecting what you want printed.
Option

Description

Print area

Specifies a range of cells to print.

Print titles - (rows to repeat at top)
Specifies rows or columns to print on each page. 

Print - (gridlines)
Allows only certain elements of your worksheet to be printed. Options include Gridlines, Black and white, Row and column headings and comments. This is most useful for selecting whether gridlines should be printed.
Page order

Controls the order in which the pages of your worksheet are numbered and printed when the printout does not fit on one page.
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 Print Preview and Page Break Preview 
Print Preview

Before you print a worksheet, click Print Preview [image: image72.bmp].
Print preview shows you how the file will look when it is printed including headers, footers and printed titles.

The Print Preview toolbar


[image: image73]
	Next
	Displays the next page to be printed. If you have multiple worksheets selected and click Next when the last page of a selected worksheet appears, Excel displays the first page of the next selected worksheet.

	Previous
	Displays the previous page to be printed. If you have multiple worksheets selected and click Previous when the first page of a selected worksheet appears, Excel displays the last page of the previous selected worksheet.

	Zoom
	Switches between a full-page view of a sheet and a magnified view. The Zoom feature does not affect printing size. You can also switch between a full-page view and a magnified view of a worksheet by clicking any area of the worksheet. 

Depending on the resolution of your monitor, you may not see certain graphics, such as thin borders, in full-page view.

	Print
	Lets you set printing options and then prints the selected worksheet. 

	Setup
	Lets you set options that control the appearance of printed sheets. 

	Margins
	Displays or hides margin handles that you can drag to adjust page margins, header and footer margins, and column widths.

	Page Break Preview
	Switches to page break preview, in which you can adjust the page breaks on the active worksheet. You can also resize the print area and edit the worksheet. The name of the button changes from Page Break Preview to Normal View if you were in page break preview when you clicked Print Preview .

	Normal View
	Displays the active worksheet in normal view.

	Close
	Closes the print preview window and returns to the previous view of the active worksheet.


Page Break Preview
Page Break Preview is found on the View toolbar. It shows you what data will go on each page so you can adjust the print area and page breaks by clicking and dragging with the mouse. 

Print Options
To set a print area

The Print Area command is useful when you want to print a specific range of cells. The print area will remain in Excel’s memory until it is cleared or replaced. The print area can be set on the Sheet tab of the Page Setup dialog box. Another way to set the print area is:

1. Select the cells to be printed

2. File menu, Print Area, Set Print Area. The print area is set.

To clear the print area

1. File menu, Print Area, Clear Print Area. The print area is cleared.
To print a worksheet

If you want to print all data on an active worksheet, press the Print button 
[image: image74] on the Standard toolbar.

If you want to print anything else, Open the File menu and click on Print to open the Print dialog box.
	Option
	Description

	Print range
	Specifies which pages to print.

	Print what 
	Specifies whether to print a selected area, actives worksheets or the entire workbook. 



[image: image75]
To print more than one worksheet: 
	To Print
	Action

	Two or more adjacent sheets
	Click the tab for the first sheet, and then hold down SHIFT and click the tab for the last sheet.

	Two or more nonadjacent sheets
	Click the tab for the first sheet, and then hold down CTRL and click the tabs for the other sheets.

	All sheets in a workbook
	Right-click a sheet tab, and then click Select All Sheets on the shortcut menu.

	Cancel a selection of multiple sheets
	Click any unselected sheet. If no unselected sheet is visible, right-click the tab of a selected sheet. Then click Ungroup Sheets on the shortcut menu.


Lists in Excel

An Excel list makes it easier to manage and analyze groups of related data in a worksheet.
The List command puts everything you use everyday right at your fingertips; sorting data, filtering data, and performing quick calculations.  You do not have to go separate menus and various buttons to accomplish these tasks. And lists will help you find answers quickly in large or complex worksheets. Create a list for part of the worksheet, and you can sort that data separately, without affecting the rest of the worksheet. 
Parts of a list

	Every column in the list has AutoFilter enabled by default in the header row. AutoFilter allows you to filter or sort your data quickly.

The dark blue border around the list clearly distinguishes the range of cells that makes up your list.

The row that contains an asterisk is called the insert row. Typing information in this row will automatically add data to the list and expand the border of the list.

A total row can be added to your list. A total row is a special row in a list that provides functions useful for working with numerical data. When you click a cell within the total row, a drop-down list of the available functions becomes available.

You can modify the size of your list by dragging the resize handle found on the bottom corner of the list border.
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Create an Excel List

	1. Highlight the range of data that you want make into a list. 
2. Right-click in the highlighted area and select Create List
3. The Create List dialog box will appear showing where the data for the list is located. Be sure to indicate whether or not the list has headers.
4. Click OK
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	The range will be identified by the blue border. AutoFilter drop-downs will be automatically enabled for each column in the list and the insert row will be added as the last row of the list. If you choose to add a total row by clicking Toggle Total Row  [image: image78.png]


 on the List toolbar, a total row will be displayed under the insert row. 
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When you select a cell, row, or column outside of the list, the list becomes inactive. An inactive list is surrounded by a blue border but does not display the insert row or AutoFilter drop-downs. 

The border will not be displayed if you clicked Hide Border of Inactive Lists on the List menu.

Add or Delete Rows or Columns in an Excel List

There are several methods to add a row or column to your list. (Note - If your list is linked to a Microsoft Windows SharePoint Services list, you cannot add or delete columns from the list, you may only add or delete rows.)

Using the list border to expand your list

Click and drag the lower right corner to highlight columns or rows to include in or remove from your list. You cannot add both rows and columns at the same time. If your new columns or rows already contain data, the data will be incorporated into the list.

Using the Resize List command on the List submenu

5. On the Resize List dialog box, click OK.

6. On the List submenu of the List toolbar, click Resize List.

7. On the worksheet select the area that you want to add or remove from the list.

· The headers must remain in the same row, and the resulting list must overlap part of the original list.
· If the selection includes cells which contain data, the data will remain in the cells within the list.

Using the Insert or Delete command on the List submenu

8. Click a cell within the list where you want to add or delete a row or column. 

9. On the List submenu of the List toolbar, click Insert and click either Row or Column. To remove a row or column, On the List submenu of the List toolbar, click Delete and click either Row or Column.

Adding a row using the insert row

Type a value in one of the cells of the insert row to quickly add data. This will automatically add the row to the end of the list and specify the next row as the insert row.

Adding a row or column using auto-expansion

If you type in a empty row or column that is adjacent to the list, the list will automatically expand to integrate the row or column into the list. 
· You can turn off auto-expansion by unchecking the Include new rows and columns in list option on the AutoFormat As You Type tab of the AutoCorrect dialogue box. This dialogue box can be displayed by clicking AutoCorrect Options on the Tools menu. 

· The list will not automatically expand if you type in a row below the list if you have the total row displayed.

Charts
Charts are rich analysis and presentation tools, and make it easier for users to see comparisons, patterns, and trends in data. For instance, rather than having to analyze several columns of worksheet numbers, you can see at a glance whether teleregistration processing is falling or rising over daily or weekly periods, or how the actual rate of registrations compares to the projected rate.

You can create a chart on its own sheet or as an embedded object on a worksheet. To create a chart, you must first enter the data for the chart on the worksheet. 

   
[image: image80]
You then select the data and click on the Chart Wizard button [image: image81.png]


 (on the Standard toolbar) The Chart Wizard will help you go through the steps of choosing the chart type and the various chart options.
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Excel will create a chart based on the data.
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Pivot Table and Pivot Chart Reports

Pivot Table Reports

A PivotTable report is an interactive table that automatically combines and compares large amounts of data. You can rotate its rows and columns to see different summaries of the source data, and you can display details for areas of interest

PivotTable reports are useful when you have large amounts of data to summarize and your original data (in an Excel worksheet) has recurring entries in a given column and/or row (for example, in the Excel worksheet below, each Name, each Month and each Region occur many times.)

We will use this Excel worksheet as a sample:
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It is important to prepare your data and make sure it is well organized before trying to make a Pivot Table report.

· Make sure the first row contains column labels, since Excel will use this data for the field names in the report. 

· Check that each column contains only one sort of data (ie, include text in one column and numeric values in a separate column.)

· Make sure there are no completely blank rows or columns within the range of data to be used for the report.

· Remove any automatic subtotals from your Excel worksheet. (The PivotTable report will calculate the subtotals and grand totals for you).

(You may wish to make a copy of your worksheet, and take the subtotals out of the copy, so you can keep the original unchanged.)

Create a Pivot Table report

1. Select a cell within the area of data to be analyzed. On the Data menu, click PivotTable and PivotChart Report. 
2. The Pivot Table and Pivot Chart Wizard dialogue box will appear.
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3. In Step 1 of the wizard, select Microsoft Excel list or database. 

4. Under What kind of report do you want to create?, select PivotTable.

5. Click Finish. 

6. The wizard will provide a worksheet area for the report and list of the available fields on the PivotTable Field List.

7. If the field list is not showing, click Show Field List [image: image86.png]


on the PivotTable toolbar.
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8. Select fields to click and drag from the field list, and decide where to drop the field on the layout. The Data Items drop area is where you would usually drop data that contains numbers (ie. “#of Visits”), which are to be summarized (ie. Summed, averaged, counted, etc.) automatically.

9. After you create a PivotTable report, you can change the layout, the format, or the level of detail of your report.

In the following Pivot Table report, we dropped “# of Visits” into the Data Items drop area.  We dropped “Name” into the Row Fields drop area, and we dropped “Month” into the Column Fields drop area.  We did not use the Page Fields drop area in this report.  If you need to organize your Pivot Table into separate pages based on a given field (for example, a separate page for each Region), you would drop that field into the Page Fields drop area.
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You can create different Pivot Table reports from the same source data. Which values you decide to aggregate depend on what questions you are trying to answer about the data.

For example, the Pivot Table report shown above tells you how many visits were made by each person, and how many visits were made in each month, with a breakdown of visits by person by month.

If you also needed to know how many visits were made within each Region, you would produce another, different Pivot Table report, as shown below.
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Summarize a Pivot Table report by Average, Count, etc.

If you need a summary other than the SUM (for example, you need an AVERAGE):

1. Select a cell in the Pivot Table report, that contains the type of data you wish to summarize differently (for example, select a cell that contains a person’s number of visits per month).

2. Click on the Field Settings button [image: image90.png]


 on the Pivot Table tool bar.

3. The Pivot Table Field dialogue box will open.(Shown in the picture below, with a blue title bar, labeled simply, “Pivot Table Field”.)

4. Select the function you need from the “Summarize by:” list.

5. Click OK.
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Change the Sort Order within a Pivot Table report

1. Click on one of the field headings of the data you want to use to sort the Pivot Table report (ie, click on the number “8”, representing Region 8, in the Pivot Table report shown above.)

2. On the Pivot Table toolbar, click “Pivot Table” to get the drop-down list of functions, then click “Sort and Top 10”.

3. Choose the AutoSort options, then click Descending or Ascending.

4. Click OK.

Change the formatting of numbers in a Pivot Table report

1. Click on a cell that contains the numerical data.

2. Click the Field Settings button [image: image92.png]


 on the Pivot Table toolbar, then click on “Number”.

3. In the Format Cells dialogue box, click the option you need in the Category list.

4. Click OK twice.

Refresh the data in a Pivot Table report

The data in a Pivot Table report is tied to the original, source data that was used to create it.  However, when the source data changes, the Pivot Table is not automatically updated.  To update the data in the Pivot Table, based on changes in the source data, you must use the Refresh Data button on the Pivot Table toolbar.

1. Select a cell in the Pivot Table report.

2. Click the Refresh Data button [image: image93.png]


 on the Pivot Table toolbar.

Using Page Fields

If you have defined a Page Field, you can use the drop-down arrow next to the field name to control which groups of data are displayed.

You can also display the data on different worksheets, based on the Page Field value.
1. Click on the Page Filed name.
2. On the Pivot Table toolbar, click on “Pivot Table”, to get the drop-down list of functions, and then click “Show Pages”.
3. The Show Pages dialogue box will appear.  Click OK.  The Pivot Table data will now be separated onto different worksheets, based on the Page Field.
Add or change fields in a Pivot Table report

You do not have to create a new report, if you need to add or change fields in an existing report.  

1. Click inside the Pivot Table report
2. Click and drag fields from the Pivot Table Field List, onto any of the drop areas on the report.
3. Click and drag any field that is on the report.  You can drag it to another drop area, or you can drag it off the report completely.
4. You can drag more than one field onto any of the drop areas.  This will create a nested report.
Create a (simple, non-interactive) Chart from a Pivot Table report

The information in a Pivot Table report can easily be converted into a simple chart. 

These instructions are to create a simple, non-interactive chart rather than an interactive PivotChart report (see instructions for the interactive Pivot Chart report below).

1. Click and drag to select the data in the PivotTable report that you want to use in your chart. (Start dragging from the lower-right corner of the data you're selecting. This will allow you to include the column and row headers in the first row and column of the report.) 

2. Click Copy [image: image94.png]


. 

3. Click a cell in a blank area of the worksheet 

4. On the Edit menu, click Paste Special. 

5. Click Values, and then click OK. 

6. Press the ESC key to end the copy and paste function.

7. The newly copied data area should remain selected (highlighted).  If not, select a cell within the data range to be charted.

8. Click Chart Wizard [image: image95.png]


 on the Standard toolbar, then follow the instructions in the Chart Wizard to create the chart.
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Pivot Chart Reports

Pivot Chart reports are always based on an existing Pivot Table report. We recommend that you create the Pivot Table first. This allows you to make sure the resulting sums or other summaries are the ones you need. The instructions below assume that you have made the Pivot Table first.

Create a default Pivot Chart report

Click a cell inside the PivotTable report, and then click the Chart Wizard [image: image97.png]


 on the Standard toolbar.

A standard chart, with default colors and settings, will be created.

It will be placed in a new worksheet.
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Create a customized Pivot Chart report

10. Click a cell outside and not adjacent to the PivotTable report.

11. Click the Chart Wizard [image: image99.png]


 on the Standard toolbar.

12. In step 1 of the Chart Wizard, click a chart type. You can use any chart type except xy (scatter), bubble, or stock.

13. In step 2 of the Chart Wizard, click a cell inside the PivotTable report. The reference in the Data range box will expand to include the entire Pivot Table report.

14. Follow the instructions in the remaining Chart Wizard steps.

Using Tools
Headers and Footers
Using Preset Headers and Footers
Preset Headers and Footers comprise samples from Microsoft and headers or footers you have used from other files in the past. To access them:

1. File menu, Page Setup

2. Select Header/Footer tab

3. From the Header and/or Footer pull-down list, select a preset header or footer.

4. Click OK

Creating Custom Headers and Footers

This is when you want to create your own Headers and Footers.

1. File menu, Page Setup

2. Select Header/Footer tab

3. Click Custom Header or Custom Footer. Both look the same and have the same capabilities.

4. Using the toolbar, complete the three sections of the dialog box.


[image: image100]
The Custom Header and Footer Buttons

The Code column shows the command that Excel will insert when the option is selected. The code will be translated to the corresponding information when the sheet is printed.

	Button
	Code
	Action

	
[image: image101]
	
	Displays the Font dialog box so you can adjust the font, size, and style of the text for each of the three sections of the header or footer.

	
[image: image102]
	&[Page]
	Inserts the page number

	
[image: image103]
	&[Pages]
	Inserts the total number of pages

	
[image: image104]
	&[Date]
	Inserts the date

	
[image: image105]
	&[Time]
	Inserts the time

	
[image: image106]
	&[File]
	Inserts the filename of the workbook

	
[image: image107]
	&[Tab]
	Inserts the name of the current worksheet

	
[image: image108]
	&[Path]&[File]
	Inserts the path and file name

	
[image: image109]
	&[Picture]
	Displays the Insert Picture dialog box so you can insert a picture

	
[image: image110]
	
	Displays the Format Picture dialog box so you can adjust picture properties


Sorting and Filtering

Using the Sort Command

The Sort command will arrange the records in your database according to the contents of a particular column. Excel will sort the following in ascending order: numbers, text, logical values, error values, and blank cells. A descending sort will reverse the above order, except for blank cells, which are always sorted last.

To sort by a single column:

1. Select a cell in the column to be sorted.

2. Press the Sort Ascending 
[image: image111] or Sort Descending button 
[image: image112] on the Standard toolbar.

Note: It is not necessary to select all the data. All record information will be kept together.

	To sort by multiple columns:

1. Select a cell in the column to be sorted.

2. Data menu, Sort. The Sort dialog box appears.

3. From the Sort by pull-down list, select the column by which you want to sort. If column IDs appear instead of column titles, under my list has, select Header row.

4. Select Ascending or Descending

5. From the Then by pull-down list(s) select the column(s) by which you want to sort.

6. Select Ascending or Descending for each.

	
[image: image113]


Sort rows by four criteria (columns)

1. Click a cell in the range you want to sort.

2. On the Data menu, click Sort.

3. The Sort dialogue box will appear.

4. In the first Sort by box click the column of least importance.

5. Click OK. The Sort dialogue box will close, and the first sort will be done by Excel.

6. On the Data menu, click Sort again.

7. The Sort dialogue box will open again.

8. In the Sort by and Then by boxes, click the other three columns you want to sort, starting with the most important.

9. Select any other sort options you wish, and then click OK.

Sort rows by months or weekdays

1. Select a cell or range you want to sort.

2. On the Data menu, click Sort.

3. The Sort dialogue box will appear.

4. In the Sort by box, click the column you want to sort.

5. Click Options.

6. Under First key sort order, click the custom sort order you want, and then click OK.

7. Select any other sort options you wish, and then click OK.

Sort by columns instead of by rows

Usually, you will want to sort by rows.  If, however, you want to sort by columns, use this procedure.

1. Click a cell in the range you want to sort.

2. On the Data menu, click Sort.

3. The Sort dialogue box will appear.

4. Click Options.

5. Under Orientation, click Sort left to right, and then click OK.

6. In the Sort by and Then by boxes, click the rows you wish to sort.

Create a custom Sort Order using your own data

To use your own data as a Sort Order, you must first create a Custom List.  You then specify this Custom List as your First Key Sort Order (under Options in the sort dialogue box).

	Potential Impact

	High

	Medium

	Low


1. In a range of cells, enter the values you want to sort by, in the order you want them, from top to bottom (for an example, see above).

2. Select the range (do not include the column header, ie, “Potential Impact”, because it is not one of the sort values.)

3. On the Tools menu, click Options, and then click the Custom Lists tab.

4. Click Import, and then click OK.

5. Select a cell in the range you want to sort.

6. On the Data menu, click Sort.

7. In the Sort by box, click the column you want to sort.

8. Click Options.

9. Under First key sort order, click the custom list you created. For example, click High, Medium, Low.

10. Click OK.

11. Select any other sort options you want, and then click OK.

You can not use a custom sort order in a Then by box. The custom sort order applies only to the column specified in the Sort by box. To sort multiple columns by using a custom sort order, sort by each column separately. For example, to sort by columns A and B, in that order, first sort by column B, specifying the custom sort order by using the Sort Options dialog box. Next, sort the range by column A, specifying its custom sort order.

Sort one column without affecting the others

Be careful using this procedure. Sorting by one column only (keeping it “disconnected” from the other columns in your table of data) may produce results you don't want, such as moving cells in that column away from other cells in the same row.

This procedure does not work if your data is in an Excel List.  The List structure protects the connection between data items in the same row.

1. Click the column heading to select the column you want to sort. 

2. Click Sort Ascending [image: image114.png]


or Sort Descending [image: image115.png]


 on the Standard toolbar.

3. The Sort Warning dialogue box will appear.

4. Select Continue with the current selection.

5. Click Sort.

6. Check your results carefully!

7. If the results are not what you wanted, click Undo [image: image116.png]


.
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Notes on Sorting

If your data is in an Excel List, the Sort tool will properly ignore the column headings.

If your data is not in an Excel List, and if there are column headings, you can tell the Sort tool to ignore the first row: on the Data menu, click Sort, and then under My data range has, click Header row

To do a case-sensitive sort: on the Data menu click Sort, click Options, and then select Case sensitive.

To find the top or bottom values in a range, such as top 10 grades or bottom 5 sales amounts, use the AutoFilter tool.

Filtering your data

Using a filter allows you to work with a portion of the records in your file by extracting only records that match a set of criteria.

Using the AutoFilter

AutoFilter works for most filtering needs, but when you have complex criteria or want to crate a copy of the information, use Advanced Filter. AutoFilter command applies pull-down lists directly to the column headings in the database. These menus are used to select the field contents, which will determine what records will display.

	Activating AutoFilter

1. Select a cell within the data

2. Data menu, Filter, AutoFilter

A pull-down list will be placed next to each column within the selected data.


	
[image: image118]


Finding Data

Find data in a worksheet:

1. To search through the entire spreadsheet, click a single cell. 

2. To search within a range of cells, select the range. 

3. From the Edit Menu select Find.

4. Type in the text you are searching for.

5. If you want to replace the text with new text click Replace and key in the new text under Replace with.

6. Choose either Replace or Replace All.  Replace will only replace the first found string of text you searched for with the new text.  Replace All will replace all of the searched text with the new text.  As soon as all the text is replaced with the new text the Find/Replace window will close.  If you choose Replace, click Find Next to go to the next string of text meeting the search criteria.  Continue until the search process is completed.

7. When all replacements are made the Find/Replace window will close.  If you want to stop at any point click Close.

Check Spelling

1. Select the range of cells you want to check.

2. To check the entire sheet, click any cell.

3. Click the Spelling button  [image: image119.bmp]., on the Standard toolbar.

Creating and Using Macros

By using a Macro you can combine all of the steps of a commonly executed task into a single command.  A Macro records your mouse clicks and keystrokes, stores them under the Macro name, and lets you play them back later.  You can use a Macro to record the sequence of commands you use to perform a certain task.  When you run the Macro, it plays those exact commands back in the same order, causing Excel to respond just as if you had entered all of the individual commands.

Record a simple Macro

The first step is to set the Security Level to Medium or Low.  If the Security Level is set to High, Excel will not allow you to record a Macro.

1. On the Tools menu, click Options. 

2. Click the Security tab. 

3. Under Macro Security, click Macro Security. 

4. Click the Security Level tab, and then select the security level you want to use. 

Then, you may record the Macro.

1. On the Tools menu, point to Macro, and then click Record New Macro. 

2. In the Macro name box, enter a name for the macro. 

· The first character of the macro name must be a letter. Other characters can be letters, numbers, or underscore characters. Spaces are not allowed in a macro name; an underscore character may be used as a word separator.

· Do not use a macro name that is also a cell reference.  You may get an error message that the macro name is not valid.

3. If you want to run the macro by pressing a keyboard shortcut key, enter a letter in the Shortcut key box. You can use CTRL+ letter (for lowercase letters) or CTRL+SHIFT+ letter (for uppercase letters), where letter is any letter key on the keyboard. The shortcut key letter you use cannot be a number or special character such as @ or #. 

· The shortcut key you define will override any equivalent default Microsoft Excel shortcut keys while the workbook that contains the macro is open.

4. In the Store macro in box, click the location where you want to store the macro. 

· If you want a macro to be available whenever you use Excel, select Personal Macro Workbook.

5. If you want to include a description of the macro, type it in the Description box.

6. Click OK. 

7. If you want the macro to run relative to the position of the active cell, record it using relative cell references. On the Stop Recording toolbar, select Relative Reference [image: image120.png]


 (so that it is highlighted). Excel will continue to record macros with relative references until you quit Excel or until you click Relative Reference [image: image121.png]


again (so that it is not highlighted).

8. Carry out the actions you want to record. 

9. On the Stop Recording toolbar, click Stop Recording [image: image122.png]


.

Run a Macro

1. Set the security level to Medium or Low.

· On the Tools menu, click Options.

· Click the Security tab.

· Under Macro Security, click Macro Security.

· Click the Security Level tab, and then select the security level you want to use.

2. Open the workbook that contains the macro.

3. On the Tools menu, point to Macro, and then click Macros.

4. In the Macro name box, enter the name of the macro you want to run.

5. Click Run.

· If you want to interrupt, press ESC.

Help Tools
Excel provides several tools to help you learn about the application’s features. There is an embedded help function, and if your system is connected to the Internet, there are help functions available from Microsoft’s web site.

	When you start the Excel application, a help function will open in the Task Pane to the right of the screen.(Getting Started)

If you are using Excel, and this Task Pane is not visible, you may click on the Help menu, then “Microsoft Excel Help”, to open the Task Pane

If there is a topic you wish to research, type it into the “Search for:” box and click on the green arrow. A search on “Comments” yielded the help topics shown in the “Search Results” box.
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The Excel Menus
File Menu

	 SHAPE  \* MERGEFORMAT 



	New…
	Creates a new blank workbook.

	
	Open…
	Opens a previously created, saved workbook.

	
	Close
	Closes the current open workbook.

	
	Save
	Saves the current open workbook.

	
	Save As…
	Allows you to save the current open workbook with a different name.

	
	Save as Web Page… 
	Saves the current open workbook in HTML file format.

	
	Remove Hidden Data…
	Creates a new version of your Excel file, without hidden text, file properties, or other information that you may not want others to see.

	
	Save Workspace…
	Saves a copy of your Excel file as a WorkSpace type file (.xlw)

	
	File Search…
	Opens the Basic File Search tool in the Task Pane.

	
	Permission
	Accesses the Information Rights Management tool, if the Windows Rights Management client is installed. Helps prevent sensitive documents from being forwarded, edited or copied by unauthorized people.

	
	Web Page Preview
	Displays the current workbook as it would appear if saved as a web page.

	
	Page Setup…
	Allows you to select options for setting up your workbook and set print options.

	
	Print Area
	Allows you to set or clear a print area.

	
	Print Preview
	Displays the open worksheet as it will appear when printed, given the current Page Setup and Print Area settings.

	
	Print…
	Allows you to choose print options and initiate printing for the open workbook.

	
	Create Adobe PDF
	Allows you to create Adobe PDF file.  (Only applicable if Adobe PDF writer is installed on your computer.)

	
	Send To
	Allows you to choose different delivery methods for the open workbook.

	
	Properties
	Provides information and general statistics about the open workbook.

	
	Recent Documents
	Provides a list of recently opened workbooks. 

	
	Exit
	Closes the Excel 2000 window.


Edit Menu

	 SHAPE  \* MERGEFORMAT 



	Undo…
	Allows you to reverse the last action taken.

	
	Repeat…
	Allows you to repeat the last action taken.

	
	Cut
	Allows you to remove selected text and graphics.  

	
	Copy
	Allows you to copy selected text and graphics.

	
	Office Clipboard…
	Opens the Office Clipboard in the Task Pane

	
	Paste
	Allows you to place cut or copied text and graphics.

	
	Paste Special…
	Allows you to place cut or copied text and graphics with specific formats.

	
	Paste as Hyperlink
	Allows you to place cut or copied text and graphics as a hyperlink.  

	
	Fill
	Allows you to fill the selected cells, based on the content of a given cell or cells (You may fill up, down, right or left, within the selected range.) Also allows you to specify the characteristics of a series (linear, growth, date, etc.)

	
	Clear
	Allows you to erase selected text. 

	
	Delete…
	Deletes cells (with shift up or shift left of remaining cells), rows or columns.

	
	Delete Sheet
	Permanently deletes the entire worksheet that is selected (and all the data on the sheet.)

	
	Move or Copy Sheet…
	Allows you to move or copy an entire worksheet.

	
	Find… 
	Allows you to locate specific text or formatting within a document.

	
	Replace… 
	Allows you to locate and change specific text or formatting within a document.

	
	Go To… 
	Allows you to quickly go to a specific page within a document.

	
	Links…
	Allows you to quickly go to links within a document.

	
	Object
	Allows you to quickly go to objects within a document.


View Menu

	 SHAPE  \* MERGEFORMAT 



	Normal
	Allows you to view the worksheet in the standard view.

	
	Page Break Preview
	Allows you to view the worksheet with page breaks.

	
	Task Pane
	Allows you to display or hide the Task Pane (normally to the right of the spreadsheet area.)

	
	Toolbars
	Provides access to the available toolbars.

	
	Formula Bar
	Allows you to display or hide the formula bar.

	
	Status Bar
	Allows you to display or hide the status bar.

	
	Header and Footer…
	Allows you to create headers and footers within your document.

	
	Comments
	Allows you to edit comments within a document.

	
	Custom Views…
	Provides access to define custom view options.

	
	Full Screen
	Allows you to enlarge the displayed worksheet to the full size of the computer monitor.

	
	Zoom…
	Allows you to increase the size of the current document.


Insert Menu

	 SHAPE  \* MERGEFORMAT 



	Cells…
	Allows you to add cells to a worksheet.

	
	Rows
	Allows you to add rows to a worksheet.

	
	Columns
	Allows you to add columns to a worksheet.

	
	Worksheet
	Allows you to add worksheets to a workbook.

	
	Chart…
	Allows you to add a chart to a worksheet.

	
	Symbol…
	Allows you to insert a symbol into a worksheet.

	
	Page Break
	Allows you to designate the locations of page breaks within a worksheet.

	
	Function…
	Allows you to insert a function into the active cell of a worksheet.

	
	Name
	Allows you to create a name to describe a cell or range when using formulas.

	
	Comment
	Allows you to include a comment about the selected cell, comments can contain information about the cell’s contents.

	
	Picture
	Allows you to insert a picture or clip art into the current worksheet.

	
	Diagram…
	Allows you to insert a diagram into the current worksheet.

	
	Object…
	Allows you to insert an object that was created in a different application into the current worksheet.

	
	Hyperlink…
	Allows you to create a hyperlink, either an internal link within the worksheet or an external link to a separate file or Web page.


Format Menu

	 SHAPE  \* MERGEFORMAT 



	Cells…
	Allows you to apply selected formatting options to the active cell(s).

	
	Row
	Allows you to apply selected formatting options to chosen rows.

	
	Column
	Allows you to apply selected formatting options to chosen columns.

	
	Sheet
	Allows you to select formatting options for the worksheet.

	
	AutoFormat…
	Allows you to apply AutoFormat features to selected cells.

	
	Conditional Formatting…
	Provides automatic formatting options to cells only when the data meets pre-defined criteria.  

	
	Style…
	Allows you to create and select predefined style(s), and apply the style(s) to a cell or range of cells in a worksheet.


Tools Menu
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	Spelling…
	Allows you to check the worksheet for spelling errors-provides recommended changes for inaccuracies.

	
	Research…
	Opens the Research tool in the Task Pane.

	
	Error Checking…
	Checks for errors in the worksheet.

	
	Speech
	Opens the Text to Speech Toolbar.

	
	Shared Workspace…
	Opens the Workspace tool in the Task Pane.  Allows you to create a Sharepoint (web-based) Workspace, if Sharepoint has been implemented on your system, and if you have the correct system privileges.

	
	Share Workbook
	Allows you to share concurrent editing of the workbook with other network users. Allows you to specify how changes are tracked and how to handle conflicting changes.

	
	Track Changes
	Provides access user change tracking tools.

	
	Compare and Merge Workbooks…
	Allows you to compare workbooks and merge the data from multiple Excel workbooks into one workbook.

	
	Protection
	Allows you to choose the protection measures to apply to your workbook.

	
	Online Collaboration
	Provides access to create an online discussion about the workbook. The Web Discussions feature enables users to attach comments to a Web page or to any document that can be opened with a browser (such as .htm, .xls, .doc, and .ppt files) so that the comments appear with the document but are stored on a discussion server.

	
	Goal Seek…
	Allows you to find the input value that a formula needs to return a given result. 

	
	Scenarios…
	Allows you to identify a set of values that Microsoft Excel saves and can substitute automatically in your worksheet.

	
	Formula Auditing
	Allows you to choose auditing commands that graphically display, or trace, the relationships between cells and formulas.

	
	Macro
	Provides access to creating automated tasks and running these tasks.

	
	Add-Ins…
	Allows you to install additional Excel features.

	
	AutoCorrect Options…
	

	
	Customize…
	Allows you to customize the Excel icons and features.

	
	Options…
	Provides access to Excel features.


`

Data Menu
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	Sort…
	Allows you to sort selected cells in alphabetical order.

	
	Filter
	Allows you to display only the rows that meet specify criteria for a selected column.

	
	Form…
	Allows you to create a form used in data entry.

	
	Subtotals…
	Allows you to define a cell to calculate subtotals.

	
	Validation…
	Allows you to validate data within your worksheet.

	
	Table…
	Allows you to define specific cells to be formatted as a table.

	
	Text to Columns…
	Allows you to format selected data into columns.

	
	Consolidate…
	Allows you to merge more than one cell of data into one cell.

	
	Group and Outline
	Allows you to group data from a worksheet into an outline.

	
	PivotTable and PivotChart Report…
	Allows you to analyze data using a pivot table or pivot chart.  The pivot table/chart allows you to quickly summarize large amounts of data into a concise, specifically defined table.

	
	Import External Data
	Allows you to access data from another source.

	
	List
	Allows you to create and work with lists.

	
	XML
	Allows you to import and work with XML data.

	
	Refresh Data
	Will update newly imported or changed data.


Window Menu
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	New Window
	Creates a copy of the current document and opens it in a new window.

	
	Arrange…
	Allows you to arrange the Excel files so that they are situated together on the Windows toolbar.

	
	Compare Side by Side with…
	Places two workbooks side by side on the screen, and allows synchronous scrolling or a reset of the relative window positions.

	
	Hide
	Hides the selected workbook.

	
	Unhide…
	Unhides a hidden workbook.

	
	Split
	Allows you to divide the open window into separate panes.

	
	Freeze Panes
	Temporarily freezes rows and columns above and to the left of the selected cell.  This allows you to scroll in the worksheet, while keeping certain rows and columns (usually the column and row headings) static.

	
	Unfreeze Panes
	This command is available if Freeze Panes is active.  It releases the “frozen” rows and columns, returning workbook scrolling to normal.

	
	Open Files
	Provides a listing of all open Excel workbooks.  You may switch to another workbook by clicking on its name..


Help Menu
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	Microsoft Excel Help
	Provides access to Microsoft Excel help.  Displays the Office Assistant where you can type in the information you are looking for.

	
	Show/Hide the Office Assistant
	Turn on/off the Office Assistant.

	
	Microsoft Office Online
	If your system is connected to the Internet, this will open a browser and go to the Microsoft Office website.

	
	Contact Us
	If your system is connected to the Internet, this will open a Microsoft web page with contact information.

	
	Check for Updates
	If your system is connected to the Internet, this will search Microsoft’s update website for updates that may apply to your system.

	
	Detect and Repair…
	Provides automatic repairs to the Excel program when files have been damaged.

	
	Activate Product…
	This is used by the installer of Excel (usually the IT staff) to activate the application after installation.

	
	Customer Feedback Options…
	This provides information on Microsoft’s customer feedback program.

	
	About Microsoft Office Excel
	Provides licensing and copyright information about the Excel program installed on the computer.
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- £ Creating Custom Headers and Footers

Sormetimes, you may want to create your own headers or footers. You can adjust the font face and the
size, add your own text, and pick up fields of information from Excel. The Header dialog box for
customizing appears here
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Adding a Custom Header or Footer

1. From the File menu, select Page Setup...
The Page Setup dialog box appears

2. Select the Header/Footer tab
3. Click CUSTOM HEADER... or CUSTOM FOOTER...
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explained here. To access these dialog boxes, click CUSTOM HEADER.. or CUSTOM FOOTER.
respectively.

- ertice
Headers and Footer |, Button Code Action
- Using Preset Headers anc [°nse Displays the Font dialog box so you can adjust the font, size, and
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2. Press the Sort Ascendii & LI v

Note: It is not necessary to select all the data. All record information wil be kept together.

Using Formulas and Functions

Formulas can contain any or all of the following: B

- [ Function [ A prewitten formula tha fakes a value or values, performs an ;.pevamj
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Microsoft Excel 2003
Using the Sort
Command
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The Sort command will arange the records
(rows) in your database according to the
contents of a particular column. Excel will sort
the following in ascending order: numbers,
text, logical values, error values, and blank
cells. A descending sort will reverse the above
order, except for blank cells, which are always
sorted last

Once data is sorted, subgroups can be
subtotaled. For more information, refer to

Calculating Subtotals in Databases.

1. Select a cell in the column to be sorted

2. From the Data menu, select Sort...
The Sort dialog box appears
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